Intuicom

BroadBandPro™ 5

User Guide
This manual is for use by purchasers and other authorized users of the Intuicom Products. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, or for any purpose without the express written permission of Intuicom Inc.

© 2000 - 2020 Intuicom Incorporated. All rights reserved.

Intuicom reserves the right to make changes to this manual without notice. Unless otherwise agreed to in writing, Intuicom assumes no responsibility or liability for the use of this manual or for the infringement of any copyright or other proprietary right and Intuicom shall deem nothing contained in this manual a warranty or guarantee.

Intuicom, BBS-58, BBS-49, BBS-24, Nitro-58, BBX, Axiom, BBPro, EB-X, EB6Plus, CommPro, WiGate, Nav-Link, TargeTracker, Intuicom Navigator II, Navigator IIm and Intuicom Communicator II, Communicator T, 1200 Data Link, and DIO are trade names of Intuicom, Inc.
Contents

Introduction .......................................................................................................................... 6
Installation .............................................................................................................................. 7
  Software Updates .................................................................................................................. 7
  Full and Field Versions ....................................................................................................... 7
BroadbandPro™ Enterprise Icon Legend .............................................................................. 8
Logging In ............................................................................................................................ 10
The Main Screen .................................................................................................................. 11
  Field Version Main Screen ................................................................................................. 11
The Discovery Pane .............................................................................................................. 12
  Top Section – Broadband Units ......................................................................................... 12
  Lower Section – Unassigned Units ..................................................................................... 14
Broadband Units Header ...................................................................................................... 14
  Expand and Collapse .......................................................................................................... 14
  Filter Access Points or Stations .......................................................................................... 15
  Filter Column by IP Address or Unit Name ......................................................................... 15
  Unit Discovery .................................................................................................................... 16
Working in the Discovery Pane ............................................................................................ 19
  Changing the Order of the Units in the Discovery Pane ...................................................... 21
  Removing Units from the Discovery Pane .......................................................................... 21
  Clearing the Entire Radio List ............................................................................................. 21
  Reassigning a Station to a different Access Point .............................................................. 22
  Locating a New Unit on the Map ....................................................................................... 22
  Accessing Radio Configuration Menus from the Discovery Pane ..................................... 23
  Working with Unassigned Units ......................................................................................... 23
Working with Main Screen Tabs .......................................................................................... 24
  Working with the Map Tab ................................................................................................ 24
    Centering the Map .......................................................................................................... 25
    Hover Over Unit Information ............................................................................................ 25
    Hover Over Connection Line Information ......................................................................... 26
    Moving Units on the Map ................................................................................................. 27
    Right Click Menu on Map ............................................................................................... 27
    Accessing Configuration Window from the Map ............................................................ 27
Links Tab ............................................................................................................................. 28
Network Tab ......................................................................................................................... 29
Event Log Tab ....................................................................................................................... 30
Tools Menu

Changing Individual Unit Login Passwords ................................................................. 31
Changing the Software Administrative Password ......................................................... 32
Enter New License Key ................................................................................................. 32
Using the Field Version .............................................................................................. 32
Requesting an Activation Key ..................................................................................... 32
Activating the Software ............................................................................................... 34
Settings ....................................................................................................................... 34
Alarms .......................................................................................................................... 35
Link Snapshot ............................................................................................................... 36
Statistics Available for Monitoring ............................................................................. 36
Notification Options .................................................................................................... 37
Entering Alarm Email Addresses ................................................................................. 37
Sending Alerts to an SMTP Server ............................................................................... 38
Adjusting Alarms ......................................................................................................... 38
Login ........................................................................................................................... 38
Launch CommPro ......................................................................................................... 39
Reports Menu .............................................................................................................. 40
Broken Links Report .................................................................................................... 40
Network Topology Report ............................................................................................ 41
Radio Configuration ..................................................................................................... 41
Wireless Statistics Report ............................................................................................. 42
Configuring an Intuicom Broadband Unit ................................................................. 43
Configuring a Unit with Multiple Radios ................................................................. 44
Diagnostics .................................................................................................................. 44
Bandwidth Test ............................................................................................................ 45
Ping Tool ..................................................................................................................... 46
Frequency Monitor ..................................................................................................... 46
Programing an Intuicom Radio .................................................................................... 47
Configuring an Access Point ....................................................................................... 47
Step 1 .......................................................................................................................... 47
Step 2 .......................................................................................................................... 47
Step 3 - Data Rates ...................................................................................................... 49
Configuring a Station .................................................................................................. 49
Step 1 .......................................................................................................................... 49
Step 2 .......................................................................................................................... 49
Drag and Drop Station Configuration ......................................................................... 50
Programming 5.8GHz Radios

Available Frequencies – Country setting
Wireless Protocols
Band Settings
Channel Widths and Data Rates
Axiom5ac Channel Width Setting
Axiom5ac – 5GHz-AC Data Rates

Programming 4.9GHz Radios
Programming 2.4 GHz Radios
Setting up a 2.4 GHz WiFi Hot Spot

Necessary Settings for a Wireless Connection

Link Optimization

Frequency Separation
802.11a Frequency Separation
802.11n Frequency Separation
802.11N Radios and 2.4GHz Frequency Separation
802.11n Radios and 4.9GHz Frequency Separation
802.11ac Frequency Separation

Optimum Signal Strength and Client Connection Quality

Optimize CCQ – Data Rate Selections

Appendix A – System Requirements
Appendix B – Technical Information
Channel Width Settings and Data Rates
Appendix C – Software Installation Troubleshooting
Appendix D – Technical Support
Appendix E – Limited Warranty
Introduction

Congratulations! With BroadBandPro™ 5 you now have the industry’s most sophisticated software, enabling you to quickly and easily configure, monitor and optimize your broadband network.

BroadBandPro™ 5 contains many exclusive, industry-first features, all designed to provide you with an exceptional user experience. Some of these groundbreaking features include:

- View real-time, bi-directional data at a glance
- Network topology diagrams.
- Event logs
- Alarms Center
- Reports Center
- Role-based security
- “Auto-Tune” alarm thresholds
- Event logging
- Detailed performance statistics
- Even easier configuration
- Improved mapping engine
Installation
For instructions on how to download and install BroadBandPro™ 5 software please refer to the “BroadBandPro™ 5 Installation Guide”.

NOTE: This manual is for Version 5 of the BroadBandPro™ software. Intuicom recommends upgrading your software to the latest version.

Software Updates
If your version of BroadBandPro™ software is unable to discover new radios it is more than likely due to the fact that you are using an older version of the software. Please go to www.intuicom.com and download the latest version of the software. If you have installed the latest version of the BroadBandPro™ and you are still having trouble discovering your radios please refer to Appendix C (page 76 and 77) of this document. Additionally, please feel free to contact Intuicom support for assistance if you are experiencing any problems with your software. See Appendix D for Technical Support Contact Information.

Full and Field Versions
Both the full version and field versions of the software are available in one download from the Intuicom website. If you pay for a license and activate the software you will be running the Enterprise version of the software, with all the available features. If you chose not to purchase an activation key you can continue to use the software in field mode, which has minimal features with the same ease of programming and connection stats that are also available in the full Enterprise version. Additionally, the field version of the software does not require internet access while the Enterprise version does.
### BroadbandPro™ Enterprise Icon Legend

BroadBandPro™ 5 has an upgraded appearance. (Table of new icons below)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BBP</strong></td>
<td><strong>BroadBandPro™ 5 Launch Icon.</strong> Can be found in Start Menu, Task Bar, or as a Desktop icon</td>
</tr>
<tr>
<td><strong>AP</strong></td>
<td><strong>Connected Access Point.</strong> Access points will appear in the Broadband Units column.</td>
</tr>
<tr>
<td></td>
<td><strong>Disconnected Access Point.</strong> When no stations are connected in Broadband Units column.</td>
</tr>
<tr>
<td><strong>S</strong></td>
<td><strong>Connected Station.</strong> Will move up in Broadband Units column when connected.</td>
</tr>
<tr>
<td></td>
<td><strong>Disconnected Station.</strong> Will appear in the Unassigned Units column.</td>
</tr>
<tr>
<td><img src="gear.png" alt="Gear" /></td>
<td><strong>Access Configuration Window.</strong> Click on this icon to open the configuration window.</td>
</tr>
<tr>
<td><img src="check.png" alt="Check" /></td>
<td><strong>Discovered Unit.</strong> Icon appears on map when units are discovered and online.</td>
</tr>
<tr>
<td><img src="progress.png" alt="Progress" /></td>
<td><strong>Processing.</strong> Icon temporarily appears on map as the unit is being read by the software.</td>
</tr>
<tr>
<td><img src="gear.png" alt="Gear" /></td>
<td><strong>Radio is Processing.</strong> Access Radio Configuration Icon turns blue when radio is processing.</td>
</tr>
<tr>
<td><img src="x.png" alt="X" /></td>
<td><strong>Offline.</strong> Icon appears on map when radio is offline.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Gear Icon" /></td>
<td><strong>Configuration Window Inaccessible.</strong> Appears in Broadband Units column when radio is offline.</td>
</tr>
<tr>
<td><img src="image" alt="Question Mark Icon" /></td>
<td><strong>Unknown Radio.</strong> Icon appears on map when radio has not been read by the software.</td>
</tr>
<tr>
<td><img src="image" alt="Plus and Minus Icons" /></td>
<td><strong>Expand &amp; Collapse Radios.</strong> Icons are in the header on Broadband Units Column. Expands and Collapses Radios in the Column.</td>
</tr>
<tr>
<td><img src="image" alt="Search Icon" /></td>
<td><strong>Unit Discovery.</strong> Icon is in the header of the Broadband Units column and opens the Discovery Drop Down Menu.</td>
</tr>
<tr>
<td><img src="image" alt="Checkboxes Icon" /></td>
<td><strong>Show Stations or Access Points check boxes.</strong> Icons appear in header of Broadband Units Column.</td>
</tr>
<tr>
<td><img src="image" alt="Filter Icon" /></td>
<td><strong>Filters.</strong> Icon appears in the Broadband Units Header and expands the filter drop down menu.</td>
</tr>
<tr>
<td><img src="image" alt="Menu Icon" /></td>
<td><strong>View Menu.</strong> Icon appears in the upper right corner of the map, and expands the View Menu.</td>
</tr>
<tr>
<td><img src="image" alt="Intucom Logo" /></td>
<td><strong>Intucom Logo.</strong></td>
</tr>
</tbody>
</table>
Logging In

When BroadBandPro™ 5 is first opened a login dialogue box opens where you are prompted to login as “Read Only” or “Admin”. If you click “Read Only” the software will open with read only capabilities. The Admin username field is filled out for you, and if you enter the Admin password and click “Login”, you will be logged in as Administrator with full control of the software and radios. In the upper left corner of the software, above the map, you will see the indicator that displays which mode you have logged into the software. It will display “Read Only” or “Admin”.

Clicking Read Only will open the software with no password needed.

Enter the Admin password and click Login

When in Admin or Read Only mode status is displayed here.
The Main Screen

The Main Screen of BroadBandPro™ 5 appears when the program is launched (Pictured below). It consists of three main areas:

1) **Discovery Pane** – This is where discovered broadband units appear. Located on the far left of the window.

2) **Map Window** – Displays location and network health data. The map is interactive, allowing you to access and dynamically interact with your Intuicom broadband units.

3) **Tabs** – Use these tabs to access various functions of the program including Link Statistics, network topology view, and event logging. These tabs are located at the top of the map window.

Field Version Main Screen

The Tabs on the top of the main screen available in the field version are the “Link” tab (pictured below), and the “Network” Tab.
The Discovery Pane

The Discovery Pane has two sections “Broadband Units”, and “Unassigned Units”. The functions in the “Broadband Units” header will be explained in later section of this guide, on page 14.

Top Section – Broadband Units

The top section of discovery pane displays the units which have been discovered and are configured as access points, or if they are a station connected to an access point.

This makes it easy to see which radios in multiple radio units are connected, their role, and status all without needing to open another window or navigate away from the current view.

The image on the following page provides an overview of the discovery pane and a description of the functions and displays within this section.
Radio display in the column include Name, IP Address, and mode of operation – Access Point (AP) or Station (S).

Clicking the blue arrow icons expands the column view to allow ease of access to basic wireless settings.

Clicking on the blue arrow will expand the radio in the column to display basic wireless settings programmed on that radio.

Icons display if the radio is configured as an Access Point (AP), or a Station (S). Green icons are for radios that are connected wirelessly to another radio. Gray icons are for radios that are not connected wirelessly. Stations not connected to an Access Point will display gray and will be in the “Unassigned Units” pane.

When the blue arrow is clicked, the unit display expands and provides basic wireless settings for quick reference.
Lower Section – Unassigned Units
The lower section of the discovery pane is titled “Unassigned Units” and displays the radios that have been discovered but not yet assigned to an access point and this includes new units programmed with Intuicom default settings. The mode icon will be gray. (Figure Below)

![Unassigned Units](image)

“Unassigned Units” are where unconfigured radios, and stations not connected to an access point will appear. Icon is gray.

Broadband Units Header
In BroadBandPro™ 5 software, the header now contains icons, and check boxes that provide the filter and discovery functions, along with an improved discovery window, and the expand and collapse radios in column feature.

Expand and Collapse
To the left of the “Broadband Units” title in the header are two gray plus and minus icons. Clicking on the plus icon will expand all the radio displays in the column, and clicking the minus sign will collapse all the radio displays.

![Expand and Collapse](image)
Filter Access Points or Stations
You can easily show only access points or stations in the column by unchecking the appropriate check box in the header column.

Filter Column by IP Address or Unit Name
When clicking on the filter icon in the “Broadband Units” header, a drop-down menu appears. The drop-down menu can be used to filter the units in the column by “IP Address”, or “Radio Name”.

Screen capture to the right show’s radios with an expanded view. The displays can all be collapsed by clicking on the minus sign icon in the header or by clicking on the blue arrow next to each radio name.

Unchecking the box next to the letter S will display only access points in the column, and unchecking the box next to AP will show only stations in the column.

Clicking on the filter icon in the header bar displays the “Filter Units” drop down menu, radios can be filtered by name, IP Address, or both.
Unit Discovery
When clicking on the magnifying glass icon in the “Broadband Units” header, the “Global Discovery” drop-down will appear. This is the new location from the bottom of the discovery pane in previous releases of the software.

Global Discovery
With the new “Global Discovery” drop-down, the broadcast packet can be sent by users when needed, by simply clicking the “Discover Now” button. Additionally, the software sends out the same broadcast packet upon startup.

Targeted Discovery
Next, is the “Targeted Discovery” below the “Global Discovery”. Routers do not pass broadcast packets, so if the network path to the radios is through a router, then the targeted discovery must be used. Type in the starting IP Address in the “Starting Address” fields, and the ending two octets of the radio address range in the “Ending Address” two fields, and click “Start”.

NOTE: You must be able to ping the radios on your network for the Targeted Discovery to work. Additionally, if you are still having problems with discovering radios, please see Appendix C (page 76 and 77) of this document.
Port Forwarding
In the “Global Discovery” drop-down menu, under the “Targeted Discovery” section, is a field where you can place a check mark in “Use Port Forwarding”. Once the check mark is placed in “Use Port Forwarding”, the “Targeted Discovery” menu will change to allow you enter the “Starting Address” of the cellular modem, and the port in that modem configured for the IP address of the radio behind the it. There are also instructions that explain to the user, that BroadbandPro™ 5 and Intuicom radios need two ports on a cellular modem to function with the software.

The software is programmed so if you designate a port number, it will use the next consecutive port for the second port forward address. The reason that two ports are needed for the radios, is because one of the ports is used for monitoring, and the second is used to file transfer (FTP) scripts to the radio when making changes.

**NOTE:** You must be able to ping the cell modem IP Address out on the network, or on the internet for Port Forwarding to work.

Ports
The two ports that Intuicom uses to communicate with the radios are:

1) 8728
2) 21

Port Forwarding Example
In this example the IP address of the cellular modem is 10.22.33.44, and the radios connected behind the cellular modem have the IP addresses of 192.168.0.100, and 101. Additionally, for this example we are going to use the ports 7000, 7001, 7002, and 7003.

In the cellular modem you will need to configure:

7000 = 192.168.0.100:8728
7001 = 192.168.0.100:21
7002 = 192.168.0.101:8728
7003 = 192.168.0.101:21

In BroadBandPro™ 5 software, after placing the check mark in Use Port Forwarding, you will need to enter the following:

10.22.33.44:7000 and click “Start”.

Intuicom Inc.
4900 Nautilus Ct. North, Suite 100
Boulder, Colorado 80301
This will discover radio 192.168.0.100, and the software will use port 7000 and port 7001, to communicate with the radio.

After the unit has been discovered and appears in the discovery column, you will then enter the information for the second radio:

10.22.33.44:7002 and click “Start”.

This will discover radio 192.168.0.101, and the software will use port 7002, and 7003 to communicate with the second radio.

This same procedure will need to be followed for each radio behind the cell modem.

**WARNING**: If you are using port forwarding with a cellular modem over the internet, BroadbandPro™ software does not encrypt packets used with port forwarding communications. Port forwarding was developed for use with cellular modems on private cellular network that are not connected to the internet.

Intuicom recommends using VPN tunneling software with any cellular modems with IP addresses on the internet.
BroadBandPro™ 5 and VPN Software
There is no additional configuration needed with using VPN software. Once a VPN connection is established to the cellular modem, you should be able to ping and communicate with the radios by their configured IP addresses.

Working in the Discovery Pane
BroadBandPro™ 5 is designed to allow you to work without the need for opening extra windows or menus. Most tasks can be addressed directly from the top-level view.

Right click on any unit brings up a menu with several options. (Figure below)

A description of each item on the right click menu follow below.

Center Map on Broadband Unit: Clicking on this option will move the map so that the unit selected will be at the center of the map display.

Configure Broadband Unit: Opens the configuration window, which can also be accomplished by double clicking on the green gear icon for each radio in the discovery pane, or on the map. Unit must have a green checkmark, or green gear icon, to be able to open the configuration window. For detailed instructions on configuring an Intuicom Broadband Radio please see “Configure a Broadband Unit” section of this document.

Restore to Defaults: Selecting this option will restore the unit to Intuicom factory default settings, which requires a reboot of the radio. If you are directly connected to the radio it will disappear from the Discovery Pane and reappear under unassigned units with the default IP address, once reboot is complete. If you are wirelessly
connected to the radio it will disappear and not reappear because the wireless connection is now lost.

**Configuration Report:** Selecting this option will generate an individual configuration report for the unit selected. If it is a multiple radio unit, a report will be generated for each radio in the unit. A system wide configuration report can be generated from the Reports Center.

**Move to Top:** Moves the selected unit to the top of the Broadband Units section of the Discovery Pane.

**Reread System:** Selecting this option will force the software to do a full read of the unit selected.

**Remove System:** Deletes a broadband unit from the database. This is helpful if a unit has been removed from the network and you do not wish to see it displayed.

**Monitor Data Statistics:** Clicking on this option will open a data statistics window on the radio giving you packets stats for the wireless link. Multiple “Data Statistics” windows can be opened at the same time. (Example Below)
Monitor Links Statistics: Clicking on this option will open a window that displays bi directional wireless links statistics for every radio in the unit. Again, multiple “Links Statistics” windows can opened simultaneously. (Example Below)

AX5-Test - AP (6.43.2) Wireless Statistics

Changing the Order of the Units in the Discovery Pane
The order in which units appear can be easily repositioned to an arrangement you prefer by two methods.

1) Dragging: Simply click and hold the unit you wish to move, drag it to the desired location in the pane, and release the mouse.

2) Move to Top: If you only wish to move one unit to the top of the display, right click on it and select “Move to Top” from the menu. This feature can be used to arrange the entire column by starting with the unit you want at the bottom, and moving each unit in the reverse order of how you want them arranged in the column to the top.

Removing Units from the Discovery Pane
As previously stated – A previously discovered unit can be removed from the column by right clicking on the radio and selecting “Remove System” from the menu.

Clearing the Entire Radio List
The entire database can be cleared by clicking on the File menu and selecting “Clear and Reset Broadband Unit List”. This will close the program and you will need to manually restart the application.
Reassigning a Station to a different Access Point

If it becomes necessary to move a station radio on your network to a different access point, with BroadBandPro™ 5 software the process has been made simple by using the drag and drop feature.

1) Locate the station you wish to move, and the access point you wish to move it to.

2) Click and hold on the green or gray S icon for the station radio, and drag it to the green or gray AP icon of the access point where you wish to connect it.

3) Release the mouse and if needed change the name, and or IP configuration in the dialogue box that pops up, then click “OK” to save the settings. (Figure below)

BroadBandPro™ 5 will automatically write all the wireless settings from the access point to the station radio for you.

Locating a New Unit on the Map

Once a new unit has been added to the network it will need to be located on the map. If you have acquired Nitro-58™ or an Axiom product with on board GPS, the units will automatically locate themselves on the map. To move the map to the radio
location with embedded GPS, simply right click on the unit in the column and select “Center Map on Broadband Unit”.
To locate a BBS or BBX product that does not have embedded GPS on the map, simply drag it from the discovery pane to the precise location on the map where it is located, then right click on the unit and select “Fix to Location”.

Accessing Radio Configuration Menus from the Discovery Pane

Simply double click on the GREEN GEAR icon in the “Broadband Units” section or the “Unassigned Units” section of the discovery pane to open the configuration window.

Working with Unassigned Units

In the lower section of the discovery pane is the “Unassigned Units” section. Radios that are not assigned to an access point or units discovered at default configuration will appear in the “Unassigned Units” section. Users have two ways to configure the unassigned unit.

1) Use the Drag and Drop feature to program the radio to an access point if the access point is visible and has the green gear icon next to it in the Broadband Units section of the Discovery Pane. See “Reassigning a Station to a different Access Point” section above in this document.

2) Double click on the unit and open the Configuration window and program in the settings manually in the window and click “Write to Unit” button to save the settings to the radio. See configuring “Configuring an Intuicom Broadband Radio” section later in this user guide for more information.
Section 5: Tabs

Working with Main Screen Tabs
Above of the main BroadBandPro™ 5 screen are the main screen Tabs.

![Main screen Tabs]

Working with the Map Tab
The map in BroadBandPro™ 5 provides information about the health of your network at a glance. The following figure describes the main map features.

![Map features diagram]
Some of the helpful features include:

A) **Zoom Bar** – Control the level of magnification on the map using the slider on the zoom bar. You can also zoom in or out on your mouse using the scroll button if your mouse is equipped with one.

B) **View All** – Snaps the view to show all radios in your network. This is helpful if you are zoomed in to a particular area on the map and wish to zoom out to see the entire network.

C) **Map Display** – Choose between an “Aerial” (photographic view) with labels, the same view with no labels, or the “Road Map” view. Default view is the “Road Map” view.

D) **Connection Line Display** – From the drop-down menu users and select the connection parameter that they want the connection lines on the map to display. These are:

- RSSI (dBm) – Signal Strength
- SNR (dB) – Signal to Noise Ratio
- Tx CCQ (%) – Transmit Client Connection Quality
- Rx CCQ (%) – Receive Client Connection Quality
- Tx Rate (Mbps) – Transmit Data Rate
- Rx Rate (Mbps) - Receive Data Rate

The color of the connection lines will show different colors (green, yellow, or red) depending on how you set the parameters for each item in the Alarm Center accessed from the “Tools” menu in BroadBandPro™ 5 software.

**Centering the Map**
Double clicking anywhere on the map will re-center the map on that location.

**Hover Over Unit Information**
Holding the mouse arrow over and individual broadband unit will display the IP address and location latitude and longitude in decimal format. (Figure below)
Hover Over Connection Line Information
Holding the mouse arrow over any connection lines between broadband units reveals useful information. BroadBandPro™ 5 also shows this data in both directions simultaneously, allowing users to quickly and easily understand each radio’s behavior.

Information displayed includes:
- Transmit and Receive rates to and from each unit – Rates are shown in Mbps
- Transmit and Receive CCQ
- Signal to Noise Ratio (SNR)
- Signal Strength
- Distance between units
- Azimuth
- Rx Packets – displays total packets received since last radio reboot.
- Tx Packets – displays total packets received since last reboot
- Uptime
Moving Units on the Map
To change a unit location on the map, click and drag it to the new location, right click on it and select “Fix to Location” from the menu.

Right Click Menu on Map
The right click menu on the map has a few added selections that are different from the right click menu in the discovery pane.

- **Fix to Location** – Fixes the unit location on the map. This will override Nitro58 and Axiom built in GPS auto location.
- **Reset location** – Removes unit from map. If you reset the location on a Nitro58 or Axiom it will auto locate back on the map.
- **Center Map on Broadband Unit** – Will move the map so the selected unit is in the center of the map.
- **Configure Broadband Unit** – Opens the configuration window.
- **Restore to Defaults** – Restores the unit to Intuicom factory default settings.
- **Reread System** – Forces a full read on the system selected.
- **Configuration Report** – Generates a configuration report on the unit selected.

Accessing Configuration Window from the Map
Simply double click on any radio on the map to open the radio configuration window.
Links Tab

In the field version of BroadBandPro™ 5 the only available tab is the “Links” tab. It provides a quick overview of link statistics for easy reference and troubleshooting without the need to hover over the link lines on the map to gain the same information.

Additionally, the “Links” tab has a button labeled “Copy to Clipboard” which allows users to copy and paste the information into a text document.

Information available on the Link Statistics tab are:

- **Tx & Rx RSSI** – Transmit and receive signal strength.
- **Tx & Rx CCQ** – Transmit and receive Client Connection Quality (percentage of packets sent across the wireless link without retransmit).
- **Tx & Rx Rate** – Negotiated data rate in Mbps.
- **Tx & Rx Pwr** – Transmit and receive power setting.
- **Distance** – Estimated distance between radios.
- **Uptime** – Time the wireless link has been up.
- **SNR** – Signal to Noise ratio (difference between signal strength and noise level).
- **Azimuth** – Direction the radio is aimed.
- **Tx & Rx Packets** – Number of packets sent over the link since it has been up.

---

Wireless Radio Link List

<table>
<thead>
<tr>
<th>Radio (ID)</th>
<th>MAC Address</th>
<th>Status</th>
<th>Radio (GHz)</th>
<th>Signal Strength</th>
<th>RSSI</th>
<th>CCQ</th>
<th>Rate</th>
<th>Distance</th>
<th>Uptime</th>
<th>SNR</th>
<th>Azimuth</th>
<th>Tx &amp; Rx Packets</th>
</tr>
</thead>
<tbody>
<tr>
<td>AWL - Test 1 (A) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 2 (B) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 3 (C) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 4 (D) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 5 (E) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 6 (F) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 7 (G) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
<tr>
<td>AWL - Test 8 (H) Radio</td>
<td>06:15:45:32:12:4F:50</td>
<td>Down</td>
<td>5.8</td>
<td>-97</td>
<td>98</td>
<td>91</td>
<td>54Mbps</td>
<td>20</td>
<td>17</td>
<td>11.5</td>
<td>1.4</td>
<td>1734</td>
</tr>
</tbody>
</table>

---

Conclusion:

The “Links” tab in BroadBandPro™ 5 offers a comprehensive overview of link statistics, making it easier for users to troubleshoot and manage their wireless links efficiently.
Network Tab
The Network Graph tab provides a block diagram of the radio connections on the network.

Hovering the mouse arrow over any unit will change colors of the blocks to show where each radio is connected. In the figure below the access point highlights orange, and the station highlights blue.
Additionally, in the Figure below when the mouse arrow is hovered over the station radio, it highlights in orange, and the access point highlights in blue.

Event Log Tab

BroadBandPro™ 5 is equipped with detailed and configurable logging capabilities. The alarm messages that are generated are based on the settings designated in the Alarm Center for each parameter that is monitored by the software. For more information on setting alarm values see “Alarms” section later in this document. Logs can be cleared by clicking the “Clear Log” button in the upper right of the “Event Log” screen, and contents of the log can be copied and pasted into a spreadsheet or word document. To copy the contents of the log, click the “Copy to Clipboard” button in the upper left of the event log screen. (Figure below)
Tools Menu

Changing Individual Unit Login Passwords

Each unit requires a password in order for the software to gain access to the radio and read the settings. The password requirements for BroadBandPro™ 5 is that it must be a minimum of 5 (five) characters in length.

For the software to work all radios must have the same password set, and then that same password needs to be set in BroadBandPro™ 5.

To set the password on a radio open the configuration window. Click on “Unit Advanced Configuration” to expand the menu. Then click on “Unit Settings” to expand that menu. In the BBS Password box type in the “New Password” field the new password, and retype it in the “Confirm” field, and then click “Write to Unit” button to change the password on that radio.

Set the same password on all the radios on the network one by one. Once you have set the password on the radios click on the “Tools” menu and the first link in the drop-down menu is “Change BroadBandPro™ Unit Login Password”. In the popup window enter the password you set on all the radios and click “OK” to save the password.

(Figures below)
Changing the Software Administrative Password

Second item in the “Tools” menu is the selection “Change BroadBandPro™ Admin Password”. If for any reason you as the administrator wish to change the Admin password, while you are logged in as administrator (see page 10 section “Logging In”) click on the “Tools” menu and from the drop-down select the second link down “Change BroadBandPro™ Admin Password” and in the popup window enter your new password and click “OK” to save the password. (Figures below)

Enter New License Key

The third selection in the Tools menu is the selection “Enter New License Key” clicking on this menu will bring up the activation Screen that first came up when you installed the software. If you are using the field version of the BroadBandPro™ 5 software this screen will pop up every time you open the software.

Using the Field Version

When you install the software the activation window pops up where you can click “Activate Now”, “Request Activation Key”, or at the bottom of the window “Use Field Version”. If you click “Use Field Version” the software will load with minimal features and the only tab available on the top of the screen will be the “Links” tab and the “Network” tab.

Requesting an Activation Key

If you have purchased the software, or are an authorized Intuicom distributor and want to activate your copy of the software you can create an email to send into Intuicom one of two ways.

1) You can click on the “Request Activation Key” and enter in your Google mail, outlook.com, or Yahoo information, and an email will automatically be created with the correct email address, title, and contents. Fill out the content with your
information and click send and you will be emailed an activation key within 24 hours.

2) If you are not using Google mail, outlook.com, or Yahoo, you will have to generate the email by copying the contents from the window (third red box from the top outlining the text in the activation window in the figure below) and pasting into the contents of an email. Fill your information in the fields in your email, and then type in the subject line “Key Request”, and copy and paste the email address “BBProKey@intuicom.com” and send in the email.

**NOTE:** When copying the contents of the Activation window into your email make sure you copy the entire “Request Key” if this is not a complete number Intuicom will not be able to generate an activation key for your installation.
Activating the Software
Once you have received a reply email from Intuicom with your activation key open the software and when the activation window pops up, click the “Activate Now” button (Figure above) and in the popup window copy and paste the activation key into the field and click “Complete Activation” to activate the software. (Figure below)

Settings
The “Settings” menu allows users to change the appearance of BroadBandPro™ 5 from light to dark mode. Simply place the bullet in the desired mode, and click “OK”.

Light Mode

Dark Mode
Alarms

The “Alarms” center is where users can tailor their installation so that alerts are relevant to their network and their wireless links. Not all wireless links are the same, as a wireless network where links are made from one intersection to the next down different roads will have stronger signal strengths than a network that has a main access point location on top of a building or tower and all the intersections are linked back to the access point location.

You can set your own parameters using the “Alarms” center sliders to select the settings you prefer, or you can use the “Auto Tune” feature to allow the software to adjust the thresholds automatically for you.

Settings in the “Alarms” center determine the color of the link lines displayed on the map as well as the entries displayed in the “Event Log”. If the thresholds are set correctly and the network does not experience any problems then the only event you should see in the Event Log is “BroadbandPro Started”. By setting the Alarms Center in this manner the only events recorded in the log will be events that are important to you and your wireless network.

To access the “Alarms” center, click on Tools and select the fifth link from the top “Alarms”. (Figure below)

![Image of Alarms Center](image)

The “Alarms” center is pictured below with optimized settings. Once you are done setting the alarms simply click the X in the upper right-hand corner to close the window settings will remain after adjustment.
Link Snapshot
In addition to the “Auto Tune” feature there is also a “Link Snapshot” button that allows you to get a quick look at the wireless connection statistics for your network. The figure below shows the “Link Snapshot” screen. There is a column titled “Ignore” that allows you to ignore problem or out of settings links that are known and of no concern to the administrators. By placing a check mark in “Ignore” emails will not be sent to recipients and if you are porting the alarms to a SMTP server those alarms will not be sent, and they will not show up in the logs.

Statistics Available for Monitoring
The same statistics that are available on the map are available in the “Alarms” center. These include:
Section 6: Tools Menu

- RSSI (dBm)
- SNR (dB)
- Tx & Rx CCQ (%)
- Tx & Rx Data Rates (Mbps)
- Ping Latency (ms)

**Notification Options**
Alarms can be issued in two ways. (Figure below)

- Selecting “e-Mail Alarm Notification” by any parameter will send an email to alarm recipients whose addresses are entered in the “Alarms Recipients” field. SNMP settings will need to be entered as well.
- Selecting “Log Alarm Notification” which will log the alarms in the “Event Log” each time the alarm is triggered. (See “Event Log Tab” section on page 30 of this document)

**NOTE:** One, both or neither can be enabled for each parameter.

### Entering Alarm Email Addresses
At the bottom of the alarms center window is where information is entered to enable email alarm notifications. (Figure below)

When entering multiple email addresses in the “Alarms Recipients” field separate multiple email addresses with a comma.
Sending Alerts to a SMTP Server
Additionally, at the bottom of the alarms center window are the fields that can be filled in to send BroadBandPro™ 5 alerts to a SMTP server. In the “SMTP Server” field enter the IP Address of the SMTP server on your network. “SMTP Login” field type the username used to log into the SMTP Server on your network, in the “Password” field type in the password, and adjust the port if different than the standard SMTP port and place the check mark in “Connect Using SSL” if your SMTP server uses SSL for login. Once complete alarms should be sent to your SMTP server. (Figure below)

Adjusting Alarms
An example of the alarm adjustments for RSSI is shown below.

Say all of the wireless links on your network run between -50 to -58 dBm, and they become unstable when the signal strength drops below -68 dBm. By setting the “Alarm Threshold” at -67 dBm when any wireless link drops in signal strength to the point where they are about to become unstable you will receive an alert, and lines will turn red on the map. By setting the “Clear Threshold” to -60 dBm when the link drops back to the range where it usually runs the alarm will clear. This same logic is applied to all the alarms on your network.

Login
The software login screen can be accessed from the “Tools” link by clicking on the 6th link from the top.

Users can access the security center to change from Read Only mode to Admin mode and vice versa while the software is running by selecting this option from the Tools menu.
See page 6 above, under “Logging In” section for additional information on the function of the security center.

**Launch CommPro**

Intuicom serial radio software, if installed, can be launched directly from BroadBandPro™ 5 software by selecting this option from the “Tools” menu.
Reports Menu
The Reports menu provides four useful reports that can be accessed easily, and can be printed or saved in .pdf format.

The reports menu is located next to the Tools menu in the upper left of BroadBandPro™ 5 software.

The four reports that can be generated from the Reports drop-down are Radio Configuration, Wireless Statistics, Network Topology, and Broken Links.

Broken Links Report
This report lists the links that are down on your network.
Network Topology Report
Produces a static copy of the Network Graph tab that is useful for visualizing the wireless connections on your network. (Figure below)

Radio Configuration
Produces a report with the configuration settings for all radios on your network. Creating a Configuration report for a single radio can be accomplished by right clicking on the radio in the discovery pane, or on the map, and then selecting “Configuration Report” from the menu (explained on page 20 and 27 of this document). (Figure below)
**Wireless Statistics Report**
Selecting this option will produce a report that will provide basic configuration details and basic wireless statistics in a single report. (Figure below)

![Wireless Statistics Report](image)

<table>
<thead>
<tr>
<th>Name</th>
<th>Address</th>
<th>Mode</th>
<th>Radio</th>
<th>SSID</th>
<th>Channel</th>
<th>Frequency</th>
<th>Power</th>
<th>Latency</th>
<th>Packets</th>
<th>Bytes</th>
<th>errors</th>
<th>Error Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>NW1</td>
<td>123.45.67.89</td>
<td>802.11a</td>
<td>2.4G</td>
<td>guest</td>
<td>1</td>
<td>2.402022GHz</td>
<td>8db</td>
<td>8</td>
<td>100</td>
<td>1000</td>
<td>1</td>
<td>1%</td>
</tr>
<tr>
<td>NW2</td>
<td>123.45.67.90</td>
<td>802.11b</td>
<td>2.4G</td>
<td>test</td>
<td>5</td>
<td>2.402022GHz</td>
<td>8db</td>
<td>8</td>
<td>100</td>
<td>1000</td>
<td>1</td>
<td>1%</td>
</tr>
<tr>
<td>NW3</td>
<td>123.45.67.91</td>
<td>802.11g</td>
<td>2.4G</td>
<td>user</td>
<td>1</td>
<td>2.402022GHz</td>
<td>8db</td>
<td>8</td>
<td>100</td>
<td>1000</td>
<td>1</td>
<td>1%</td>
</tr>
</tbody>
</table>
Configuring an Intuicom Broadband Unit

Open the configuration window by double clicking on the green gear icon on any unit in the discovery pane.

The following information is displayed in the configuration window:

- Unit Name
- IP Address
- Subnet Mask
- Default Gateway
- Basic Settings - Display
  - Radio Name – Radio name can now be changed
  - MAC Address
  - Mode
  - Band
  - Channel Width
  - Frequency
  - SSID
  - Encryption
  - Pre-shared Key
  - Tx Power

Below the settings display are the fields that can be changed when programming the radio. These include:
Section 8: Configuration

- Country
- Protocol
- Band
- Mode
- Channel Width
- Frequency
- SSID
- Encryption
- Key
- Radio Name

Configuring a Unit with Multiple Radios
Multi-radio units may be configured from a single window. BroadBandPro™ 5 will display each radio as a unit when the Configuration Window is accessed. (Figure below)

Diagnostics
BroadbandPro™ 5 also includes tools that are useful in optimizing your wireless network. These tools include:

- Bandwidth Test
- Ping Test
- Frequency Monitor

These tools can be accessed by selecting the “Diagnostics” tab in the configuration window. (Figure on next page)
Bandwidth Test

The “Bandwidth Test” is used to measure the throughput between two broadband units. Users can test the bandwidth between the unit that they are presently logged into (have the configuration window open), to a remote unit by selecting the remote system from the drop-down menu and clicking the “Start” button, to start the test. (Figure below)

**WARNING:** If you try to perform a wireless bandwidth test from a remote unit (a radio that you are connected to through its wireless link), running the test will log you out of the remote unit. The bandwidth test uses the wireless link, and drops that same link when running the test. Once you have been logged out of the remote unit, you will have to physically connect to it through the Ethernet port, or power cycle the unit to stop the test and bring the radio back on line.
Ping Tool
You can ping any of the remote units using the Ping Tool by selecting the “Ping” tab in the “Diagnostics” window. Select the remote system from the drop-down menu, and click the “Start” button, to start the ping test. (Figure below)

Frequency Monitor
To scan the spectrum with any radio in a single, dual, triple or quad unit, from in “Diagnostics” window select the Radio from the “Monitor Radio” drop-down menu, and click the “Start” button, to start the monitor.

The Frequency Monitor displays the signal strength of all devices (The Noise Level) that it picks up in the spectrum for the particular radio selected. It displays the bars on the graph for the frequency where the noise is recorded. You can then use the graph to program the radio to use the frequency where low noise is recoded.

Typical noise floor is -115 dB so if the bars on the graph are displayed at -90 to -75 dB or stronger you will know that there is interference on that frequency and can then program the radio to avoid the frequency where the high noise level is seen.
Programming an Intuicom Radio
The following is an example of how to program an Intuicom broadband radio. Explanation covers both station and access point configurations.

NOTE: For information on how to connect and power on an Intuicom broadband radio please refer to the “Axiom & BBX – Quick Start Guide”.

Once the radio has been powered on, connected to your PC, and discovered by BroadBandPro™ 5 software, click the green icon, on the unit in the discovery pane to open the configuration window.

Configuring an Access Point
Step 1
A) Enter the Unit Name
B) Enter the IP Address
C) Enter the Subnet Mask
D) Enter the Gateway – default gateway
E) Click “Write to Unit”

NOTE: Typical unit names are the intersection or location of the radio. If you do not know the unit name, IP address, subnet mask, or default gateway, proceed to Step 2 and program the wireless settings. Step 1 can be programmed at a later date. MAKE SURE you change the last octet of the default IP address so each radio has a unique IP address for use until the address scheme is known and can be programmed.

Step 2
A) Select the Country - From the drop-down menu. For 2.4GHz radios this field only has one selection. For 4.9GHz radios this field is limited to two country codes and selecting either does not change the frequency selections. For 5.8GHz radios leaving the default selection of “US 5.8 direct” limits the frequency selection to the 5740 – 5830/50 range. Selecting “no_country_set” from the drop-down menu will expand the frequency selections to include the 5175-5260 range.
B) Set the Protocol – Selections are 802.11, nstreme, nv2, any, and unspecified. Do not use any or unspecified. Default is nv2, and all radios must have the same protocol set to form a wireless connection.
C) **Set the Band** – Default setting is typically the correct setting. This is only changed if you are programming an Axiom or BBX product to be compatible with a BBS or Nitro-58 legacy product.

D) **Set the Mode** – Access Point, or Station. This will designate the unit’s role in the wireless link/network.

E) **Set the Channel Width** – This setting needs to match on the Access Point and all connected Stations. For Nitro-58n, Axiom, and BBX products the selection of 5 and 10MHz wide channels will only use 802.11a data rates. Selecting 20, 40MHz Above or Below channel widths will use the 802.11n data rates and the 2x2 MIMO antenna.

F) **Set the Frequency** – Depending on your previous selections (Country and Channel Width) the frequency drop-down will display the available frequencies. Care must be taken to select frequencies that do not interfere with each other if multiple radios are installed at a single location.

G) **Set the SSID** – Make sure you have exactly what you typed in this field for programming station radios. SSID is case sensitive and must match on the access point and all connected stations.

H) **Set the Encryption** – Select from None, or either of the -PSK options. The EAP options are only used if your network uses a Radius Server for authentication. If you do not know what a Radius Server is, then select either of the -PSK options. Additionally, when the nv2 protocol is selected only WPA2-PSK selection will be available.

I) **Set the Key** – The encryption key must be a minimum of 8 characters long. Suggestion is to make it as long as possible with different characters such as letters, numbers, and special characters. If the Key is less than 64 characters then the radios are using 128-bit encryption. If the key is longer than 64 characters the radios are using 256-bit encryption. The field is limited to a key length of 65 characters.

**NOTE:** Due to processor utilization 256-bit encryption is not recommended unless it is a single access point to a single station connection. If the access point has multiple stations connected to it 128-bit encryption is recommended.

**SHORTCUT** – You only need to enter the Key once into the radio. Suggestion is to type it up in a Notepad document, save it, and copy and paste the key into the field in the software. This way you do not have to remember a 35-character key, and you will avoid mistyping the key when you enter it.
**J) Set Radio Name** – If you wish to change the radio name from its default of Radio1, 2, 3, or 4, simply enter the new name you wish to assign to the radio module.

**Step 3 - Data Rates**

**K) Click on the blue arrow icon to expand the “Advanced Configuration” menu.**

**L) If you are using 5 or 10MHz Channel Width settings, check off all the 802.11a/g Supported Rates**

**M) Check off only the lowest 802.11a/g Basic Rates**

**N) 802.11n rates are not available and should not be selected.**

**O) Click “Write to Unit”**

**P) If you are using 20MHz, 40MHz Above or Below channel width settings, leave only the lowest supported and basic rates selected for the 802.11a/g rates, and select all of the 802.11n supported rates, and only the lowest 802.11n basic rates**

**Q) Click “Write to Unit”**

**Configuring a Station**

Configuring a radio as a station you will perform the exact steps outlined in the section “Configuring and Access Point” on the previous page of this document.

**Step 1**

- **A) Enter the Unit Name**
- **B) Enter the IP Address**
- **C) Enter the Subnet Mask**
- **D) Enter the Gateway – default gateway**
- **E) Click “Write to Unit”**

**Step 2**

- **A) Select the Country** – Use the same setting as the access point
- **B) Set the Protocol** – Must match the access point it will connect to
- **C) Set the Band** – Should have the same band as the Access Point in the selected setting. Example: If the Access Point is set to 5GHz-A Station must be set to 5GHz-A, or A/N
- **D) Set the Mode** – Station
- **E) Set Channel Width** – Must match Access Point
F) **Set Frequency** – This does not have to match the Access Point as the station will auto detect what frequency the Access Point is set to and connect on that frequency. Suggestion is to set it to match the AP

G) **Set SSID** – Must EXACTLY match the Access Point

H) **Set Encryption** – Must match the same setting used on the Access Point

I) **Set the Key** – Again, must EXACTLY match the Access Point Key

J) **Set Radio Name** – If desired

K) Click on the blue arrow icon to expand the “Advanced Configuration” menu.

L) **Set 802.11a Data Rates** – Match the settings on the Access Point

M) **Set 802.11n Data Rates** – Again, match the settings on the Access Point

N) Click “Write To Unit”

**Drag and Drop Station Configuration**

The BroadBandPro™ 5 software has a unique feature that allows a simple programming of the station radios. If you are able to connect to both the access point radio and station radio at the same time, as shown on the following picture, this feature can be used.

Once the access point has been configured following the previous steps, connect the unit to be configured as a station radio to the same switch as the access point. Click on the Discovery icon in the Broadband Units header, and click “Discover Now” button. Once the radio is discovered click and hold on the gray “S” icon and drag it up and drop it on the gray or green “AP” icon and release it. A pop-up window will come up and you will need to set the:

1) Unit Name
2) IP Address
3) Subnet Mask
4) Default Gateway and click “OK”
BroadBandPro™ 5 will automatically write all the wireless settings to the station radio without the need to open the configuration window and program each setting to the radio.

When both Station and Access Point radio are connected to the PC and the Access Point radio has been configured both radios will appear in the discovery panes as shown above.

Click on the gray “S” icon and drag the radio to be configured onto the access point gray “AP” icon and release the mouse button.

When the pop window comes up, fill out the System Name, IP Address, Gateway, and Netmask for the (Target) Radio and click “OK” to write all the access point wireless settings to the station radio.
**Programming 5.8GHz Radios**

All the radios manufactured by Intuicom are 2x2 MIMO 802.11n radios. There are a few details that users should know about when programming the Intuicom 802.11n units.

**Available Frequencies – Country setting**

The default configuration for the 5.8 GHz broadband radios is the country code set to “us 5.8 direct”. Setting the country code to this value limits the available frequencies to 5740 MHz to 5830 MHz which is the range of the spectrum for outdoor use.

If the user desires to make available the lower portion of the 5.8 GHz spectrum, 5175 MHz to 5260 MHz this range of the spectrum can be used by changing the “Country” code to “no_country_set”. Once this has been selected the frequency drop-down menu will contain frequencies in the lower range, from 5175 MHz to 5260 MHz and the upper range from 5740 MHz to 5830 MHz. The list of frequencies will change depending on the channel width and only display allowed frequencies for the selected channel width.

**NOTE:** Intuicom does not recommend opening up the spectrum unless there is an absolute need to do so, and low transmit power settings are being used. This is due to FCC Regulations governing the use of the indoor portion of the 5.8 GHz spectrum.

**WARNING** - When selecting the frequency for any wireless link the setting on the access point is what the radios will use when they communicate, and the setting on the station if it is not set to the same frequency as the access point, will be incorrect. Additionally, if you have an access point set to “no_country_set” and it is programmed to use the a frequency in the 5175-5260 range, while the station is set to “us 5.8 direct” and programmed to use a frequency in the 5740-5830 range the wireless link will not connect. This is because the station does not have the same frequencies available as the access point. They must be programmed with the same country code and in the same frequency range to establish a connection.

**Wireless Protocols**

All Intuicom products have three wireless protocols available. These are as follows:

1) 802.11
2) Nstreme
3) NV2

802.11 is the IEEE standard protocol that is used for inter vendor operability. In short that that different manufacturer’s products can connect wirelessly.

NStreme and NV2 are proprietary protocols that can be used to prevent 802.11 devices from connecting to Intuicom radios.

**NOTE:** On bandwidth tests the NV2 protocol provides slightly higher throughput across the wireless link.

**Band Settings**

In the main configuration window, the “Band” now has a drop down with different selections.

The Following table shows the different band selections that are available in the legacy and new broadband products available from Intuicom. Products are listed by family type which includes all models for the type designation. For example, the BBS family of products includes BBS-AP58, BBS-AP585858, BBS-AP5858, BBS-SA58, and BBS-58. The reason that these are listed by product family is because each family of products contains the same radio modules so the band selection for all the products will be the same.

<table>
<thead>
<tr>
<th>Product</th>
<th>Available Bands</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBX5 Family</td>
<td>5GHz-A, 5GHz-A/N, and 5GHz-N</td>
</tr>
</tbody>
</table>

Copyright Intuicom, Inc. 2020
BBX2 Family 2GHz-B, 2GHz-G, 2GHz-N, 2GHz-B/G, 2GHz-G/N
BBX4 Family 5GHz-A, 5GHz-A/N, and 5GHz-N
AX5 Family 5GHz-A, 5GHz-A/N, and 5GHz-N
AX2 Family 2GHz-B, 2GHz-G, 2GHz-N, 2GHz-B/G, 2GHz-G/N
AX4 Family 5GHz-A, 5GHz-A/N, and 5GHz-N
AX5ac Family 5GHz-A, 5GHz-N, 5GHz-AC, 5GHz-A/N, 5GHz-N/AC, and 5GHz-A/N/AC

Legacy Product Available Bands
BBS 58 Family 5GHz-A
Nitro 58 Family 5GHz-A
Nitro 58n Family 5GHz-A, 5GHz-A/N, and 5GHz-N
BBS 24 Family 2GHz-B, 2GHz-G, and 2GHz-B/G
BBS 49 Family 5GHz-A

For most installations, the default “Band” setting will work. The typical reason for changing the band is to program the Axiom or the BBX products to connect to a legacy product like the BBS-58 or Nitro-58 product. For these installations, the 5GHz-A band will be the appropriate selection.

Additionally, when changing the band from the default selection the “Channel Width” drop down will change to reflect the available settings for the new band setting.

The example below is using an Axiom 5ac radio. The “Band” has been changed to 5GHz-A and the “Channel Width” drop-down menu now reflects the available channel widths for the selected band.
Channel Widths and Data Rates

1) The “Channel Width” selection is different than the 802.11a legacy products such as the BBS and Nitro-58 products.
   a. “Channel Width” Selection for the 802.11a units is:
      i. 5 MHz
      ii. 10 MHz
      iii. 20 MHz
      iv. 40 MHz
   b. “Channel Width” Selection for the 802.11n units is:
      i. 5 MHz
      ii. 10 MHz
      iii. 20 MHz
      iv. 20/40 MHz Above
      v. 20/40 MHz Below

(Figure Below)

2) The 2x2 MIMO data rates do not come into effect for the 5MHz and 10 MHz wide channel selections. For these two channel widths the “Advanced Configuration” drop-down screen data rates selections are the same as the BBS-58 and Nitro-58 radios. You will check off all the 802.11a/g supported rates, and only the lowest 802.11a/g basic rate. (Figure below)
When the radio is set to 20 MHz, 40 MHz Above, or 40 MHz Below the “Advanced Configuration” drop-down menu will have additional settings for data rates, and guard interval.

a. When using 2x2 MIMO by selecting the 20 MHz, 40 MHz Above, or 40 MHz Below channel widths leave the 802.11a supported and basic rates with the lowest data rate selected.

b. Leave Guard Interval at default which is 400.

c. Select all the 802.11n supported rates, and only the lowest 802.11n basic rate.

**NOTE:** When you select 802.11n Supported Rates MCS 0-7, the unit will only be using one spatial stream. If you are using MCS 0-15 the unit will be using two spatial streams.
Scroll down on the screen to configure the 802.11n data rates. (Figure Below)

For 20MHz and wider channel widths set the 802.11a/g rates with only the lowest supported and basic rates selected

For 20MHz and wider channel widths set the 802.11n rates selecting all of the supported rates and lowest basic rate
**NOTE:** If you are programming N radios to connect to both A and N radios then you will need to check off all or some of the 802.11a data rates, because these are what the A radios will use when connected to an N radio.

N Data Rates are listed as MCS rates. These data rates are termed HTMCS which stands for High Throughput Multiple Coding System. It is these data rates that allow the 40MHz Above or Below channel widths to run up to 300Mbps maximum throughput.

**Axiom5ac Channel Width Setting**
The Intuicom 802.11ac unit can achieve a maximum throughput of 867Mbps over the wireless connection, in ideal conditions. To achieve the high throughput 80MHz wide channels are available for programming. (Figure Below)

The same thing applies with the channel width selection as the 802.11a and 802.11n units, where the wider the channel width the higher the bandwidth. The Axiom5ac units are backwards compatible, to the 802.11a and 802.11n radios and have a wide selection of bands and channel widths available. By selecting the appropriate band, and channel width, the AX5 units can be programmed as 802.11a, 802.11n, or 802.11ac radio, or it can run a combination of all three bands by selecting the 5GHz - A/N/AC.

**NOTE:** If you are programming an Axiom5ac radio to connect with 802.11a, 802.11n, and 802.11 ac radios, you will need to select supported and basic rates for all three bands in the data rates settings as 802.11a radios will use the a/g data rates, 802.11n radios will use the n data rates and the 802.11ac radios will use the ac data rates.
A table of channel width selections by band is listed below.

<table>
<thead>
<tr>
<th>Unit</th>
<th>802.11a</th>
<th>802.11n</th>
<th>802.11ac</th>
</tr>
</thead>
<tbody>
<tr>
<td>AX5ac</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>20/60MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>40/40MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>60/20MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>20/60MHz Below</td>
</tr>
</tbody>
</table>

**Axiom5ac – 5GHz-AC Data Rates**

If you select any band that includes 5GHz-AC then the data rates menu will change and the 802.11ac data rates menu will appear. This will appear below the 802.11n menu discussed in the previous section. You will need to scroll down on the “Advanced Configuration” window to see the 802.11ac Data Rates.

When the AC band is selected you will notice that the 5, 10, and 20MHz wide channel selections disappear. This is because they are not available when using the 802.11ac band.

In a similar manner to how the N data rates are configured you will need to deselect all the 802.11a rates with the exception of the lowest basic and supported rates. Additionally, deselect all the 802.11n data rates, and check off all the supported 802.11ac rates and only the lowest basic rate.

**NOTE:** Best bandwidth results were achieved using the 802.11 protocol, and matching MCS0-7 on both the basic and supported rates, leaving MCS0-8 and MCS0-9 unselected.
Section 9: Additional Settings

Programming 4.9GHz Radios

The Intuicom 4.9GHz radios are now 2x2 MIMO 802.11n units. When programming the 4.9GHz AX4 and BX4 units there are two differences between them and the AX5 and BX5 products line.

1) The spectrum is limited to 50MHz wide running from 4940-4990MHz.
2) The Country selections are japan3 or japan4.

**NOTE:** The 4.9 GHz Licensed Public Safety Spectrum is 4940 MHz to 4990 MHz. To make the frequencies in that range available the “Country” code must be set to japan3 or japan 4. Additionally, the unit cannot be set to no_country_set to expand the available frequencies like the 5.8GHz radios can be. This is due to FCC regulations.

The same 5MHz, 10MHz, 20MHz, 40MHz Above, and 40MHz Below channel width selections are available in the AX4 and BX4 units. (Figure below)

![Programming 4.9GHz Radios Diagram](image)

**Programming 2.4 GHz Radios**

The standard AX2 or BX2 units have one difference from the other Intuicom Products. The differences are as follows:

1) “Country” code is set to “us 2.4 crossroads” and there are no other selections available.
When the “Country” code is set to “us 2.4 crossroads” the available frequencies are displayed in the frequency drop down menu as 2412 MHz to 2462 MHz. Additionally, the AX2 and BX2 radios are also 2x2 MIMO and have the same channel width selections as all the 802.11n products. (Figures below)

**NOTE:** Like the 5.8GHz products, the 4.9GHz and 2.4GHz products do not use the 2x2 MIMO connection when they are set to the 5MHz or 10MHz channel widths. For both these products the data rates will be configured as explained on pages 53 and 54, of this document.

**Setting up a 2.4 GHz WiFi Hot Spot**
To set up a 2.4 GHz radio as a WiFi Hot Spot the following settings must be used.

1) Mode – Access Point  
2) Channel Width – 20 Mhz  
3) Protocol – 802.11

When these settings are used the SSID will appear as available WiFi networks on Laptops and Cell Phones.

**Necessary Settings for a Wireless Connection**
On most wireless networks one radio needs to be set as an access point, and the other as a station. However, there are exceptions to that rule such as a Mesh Networks where all radios are set as access points, and the use of standalone repeaters where
the repeater is also set as an access point. Two access points can connect over air, where radios set as stations have to connect to an access point. Regardless of the mode setting there are five settings that must match for two radios to form a wireless link. These are as follows:

1) SSID – Must be exactly the same on access point and all connected stations.
2) Channel Width - Must be the same on access point and all connected stations.
3) Encryption – If the access point is using WPA-PSK then the stations must be set to the same. Same applies to WPA2-PSK.
4) Pre-shared Key - Must be exactly the same on access point and all connected stations.
5) Protocol - Must be the same on access point and all connected stations.

**NOTE:** If your radios are not connecting check these five settings and make sure they match.
Link Optimization

Frequency Separation

If your deployment has multiple access point radios in a single location, or more than one radio at an intersection you will need to know how to program the radios so that the frequencies are separated and do not interfere with each other.

Intuicom recommends a 5MHz separation between each radio IF possible.

In the previous “Frequency Selection” section of this document the change in available frequencies was explained. In this section we will cover how to program the frequencies. The frequency drop-down menu is shown in the image below.

In the “Necessary Settings” section of this document (page 61) programming of the radios was covered and one of the settings that is required to form a wireless link between two radios is “Channel Width”. The channel width selection has grown with the addition of 802.11n and 802.11ac radios, combined with new regulations allowing 802.11n channel widths in the 2.4GHz and 4.9GHz spectrums. The following is a list of new and legacy Intuicom products and the available channel widths for each.

<table>
<thead>
<tr>
<th>New</th>
<th>802.11a Channel Widths</th>
<th>802.11n Channel Widths</th>
<th>802.11ac Channel Widths</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBX5</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>BBX2</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>BBX4</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>AX5</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>AX2</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>AX4</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
<tr>
<td>AX5ac</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>20/60MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>40/40MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>60/20MHz Above</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>20/60MHz Below</td>
</tr>
</tbody>
</table>
### Section 10: Link Optimization

<table>
<thead>
<tr>
<th>Legacy</th>
<th>802.11a Channel Widths</th>
<th>802.11n Channel Widths</th>
<th>802.11ac Channel Widths</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBS-58</td>
<td>5, 10, 20, 40MHz</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Nitro-58</td>
<td>5, 10, 20, 40MHz</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>BBS-24</td>
<td>5, 10, 20, 40MHz</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>BBS-49</td>
<td>5, 10, 20, 40MHz</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Nitro-58n</td>
<td>5, 10MHz</td>
<td>20, 40MHz Above &amp; Below</td>
<td>None</td>
</tr>
</tbody>
</table>

#### 802.11a Frequency Separation

For the 802.11a radios the association between channel width and frequency is pretty simple. Whatever frequency you use, it is at the center of the channel width you selected.

**Example:** Frequency of 5760 using a 40 MHz wide channel means that the radio will be using from 5740 to 5780 for communications. If it were a 20MHz wide channel at 5760 it would be using 5750 to 5770 frequency range for communications.

An example of frequency selections for 4 different radios in a single location using 20MHz wide channels is shown below:

Radio1 = 5735
         Center
         5755
         Separation = 5 MHz
         5760

Radio2 = 5770
         Center
         5780
         Separation = 5 MHz
         5785

Radio3 = 5795
         Center
         5805
         Separation = 5 MHz
         5810

Radio4 = 5820
         Center
         5830

#### 802.11n Frequency Separation

For 802.11n radios the association between channel width and frequency is a bit more complicated. For the 5, 10, & 20MHz wide channel widths the explanation of the
802.11a frequency separation applies. The difference comes in when using the 40MHz Above or 40MHz Below setting.

The 802.11n radios are 2x2 MIMO (multiple in multiple out) radios. Which on a mechanical level means that the radio module has two antenna connectors on it, and the antenna has two connectors on it, and the antennas are literally two in one, where they have vertical (Channel0) and horizontal (Channel1) antennas built into one device. This setup relates to channel width when selecting the 40MHz Above or Below settings where each component of the antenna (vertical or horizontal) has a 20MHz wide channel associated with it. The relationship of the frequency selection is that the first 20MHz wide vertical channel (Channel0) is centered around the selected frequency and the additional 20MHz wide channel (Channel1) is either above it or below it depending on the selection.

**Example:** Selecting 5750 using 40MHz Above selection means that the vertical channel (Channel0) is using 5740-5760 for communications, and the horizontal channel (Channel1) is using from 5760-5780. So, the radio is using from 5740-5780 for communications.

An example of frequency selections for 2 802.11n radios at a single location using 40MHz wide channels is given below is given below.

Radio1 @40MHz Below =
- Channel0 5740
- 5750
- 5760
- Center 5780

10MHz Separation

Radio2 @40MHz Above =
- Channel0 5790
- 5800 Center
- 5810
- 5810

5820
5830

From the example above you can see that two 802.11n radios both set to 40MHz wide channels will use up almost the entire upper band of the 5.8GHz spectrum. If there is a
need to add a third radio at the same location, the use of the country code “no_country_set” covered in the previous “Frequency Selection” section of this document will need to be utilized in order to open up the lower portion of the 5.8GHz spectrum for use. This will provide enough spectrum to separate 3 radios and keep them from interfering with each other.

If you are daisy chaining wireless links down a road from intersection to intersection every three links will require the reuse of frequencies. The assumption being that links are far enough apart that by the time a frequency is reused it is far enough away from the first radio link using that frequency that interference is minimal to none at all.

802.11N Radios and 2.4GHz Frequency Separation
The 2.4GHz spectrum runs from 2407MHz up to 2467MHz. When setting the channel width to 40MHz Above your selections are limited to 2422 to 2437, and when setting the channel width to 40MHz Below your selections are limited to 2442 to 2457. Given these selections it is impossible to have two 2.4 GHz radios using 40MHz wide channels at a single location without them interfering with each other.

Example: Radio1 @ 40MHz Above set to 2422 runs from 2412-2452, Radio2 @ 40MHz Below set at 2457 runs from 2567-2427. This means both radios will be using the 2452-2427 portion of the spectrum and interfering with each other.

Intuicom suggests using 5, 10, and 20MHz wide channel widths when deploying multiple 2.4GHz radios at a single location to ensure channel separation is achieved.

802.11n Radios and 4.9GHz Frequency Separation
Much like the 2.4GHz spectrum the 4.9GHz public safety spectrum is quite narrow. The spectrum runs from 4940-4990MHz. Likewise, when using a 40MHz Above channel width your frequency selection is limited to 4950-4960, and when you are using a 40MHz Below setting your selection is limited to 4970-4980. So again, there is no way to separate two radios at a single location using the 40MHz wide channel widths.

Example: Radio1 @ 40MHz Above set at 4950 runs from 4940-4980, and Radio2 @ 40MHz Below set at 4980 runs from 4950-4990. This means that from 4980-4950 the radios will be interfering with each other.
Again: Intuicom suggests using 5, 10, and 20MHz wide channel widths when deploying multiple 4.9GHz radios at a single location to ensure channel separation is achieved.

**802.11ac Frequency Separation**
For the 802.11ac radios to achieve the 866Mbps throughput over the wireless link requires the use of 80MHz wide channels. These are also 2x2 MIMO radios and use 2 channels per antenna to achieve the higher data rates. So, the frequency usage depending on the channel selection can be quite complicated. A table of the channel widths and the frequency usage is shown below.

**Examples: Frequency Usage**

**20/60MHz Above @ 5765 Frequency Setting =**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Frequency Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5765 Center</td>
</tr>
<tr>
<td></td>
<td>5775</td>
</tr>
<tr>
<td>1</td>
<td>5785</td>
</tr>
<tr>
<td></td>
<td>5795</td>
</tr>
<tr>
<td>2</td>
<td>5805</td>
</tr>
<tr>
<td></td>
<td>5815</td>
</tr>
<tr>
<td>3</td>
<td>5825</td>
</tr>
<tr>
<td></td>
<td>5835</td>
</tr>
</tbody>
</table>

**40/40MHz Above @ 5765 Frequency Setting =**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Frequency Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5745</td>
</tr>
<tr>
<td></td>
<td>5755</td>
</tr>
<tr>
<td>1</td>
<td>5765 Center</td>
</tr>
<tr>
<td></td>
<td>5775</td>
</tr>
<tr>
<td>2</td>
<td>5785</td>
</tr>
<tr>
<td></td>
<td>5795</td>
</tr>
<tr>
<td>3</td>
<td>5805</td>
</tr>
<tr>
<td></td>
<td>5815</td>
</tr>
</tbody>
</table>

**60/20MHz Above @ 5785 Frequency Setting =**

<table>
<thead>
<tr>
<th>Channel</th>
<th>Frequency Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5745</td>
</tr>
<tr>
<td></td>
<td>5755</td>
</tr>
<tr>
<td>1</td>
<td>5765 Center</td>
</tr>
<tr>
<td></td>
<td>5775</td>
</tr>
<tr>
<td>2</td>
<td>5785</td>
</tr>
<tr>
<td></td>
<td>5795</td>
</tr>
</tbody>
</table>
Section 10: Link Optimization

Channel3  5805
          5815

20/60MHz Below @ 5805 Frequency Setting = 5735
  Channel0  5745
            5755
  Channel1  5765
            5775
  Channel2  5785
            5795
  Channel3  5805 Center
            5815

As you can see the 5.8GHz upper band runs from 5730-5850 and is only 120MHz wide so it is not possible to run two radios in the upper 5.8GHz spectrum without interfering with each other. Setting the radio to “no_country_set” as explained in the “Frequency Selections” section of this document will allow the use of the lower band and a radio can be programmed to function in that spectrum which would allow two 802.11ac radios at a single location and allow them to establish communications without interfering with each other.

As stated earlier, when the channel width is selected the frequency selection will change to reflect the available frequencies for that channel width.

Optimum Signal Strength and Client Connection Quality

Once the connection is up and displayed in BroadBandPro™ 5 you will need to know what the connection statistics are, that you are looking at, and what you would like to see to optimize your wireless link. These are as follows:

- **RSSI** – Optimum Signal Strength is between -50 dB. -40 dB to -50 dB is hot but acceptable (nothing stronger than -40 dB). -50 dB to -70 dB is acceptable.
- Three things effect signal strength:
  - **Channel width** – 40 MHz wide channel will give a weaker signal over the same distance as a 20, 10, or 5 MHz wide channel. If your signal is too strong try increasing the channel width. If it is too weak try using a narrower channel.
**Section 10: Link Optimization**

- **Transmit Power** – If the signal is too strong lower the transmit power if it is too weak raise it.
- **Antenna Alignment** – Misaligned antennas can affect your signal strength dramatically, so try tweaking the alignment on the antennas until the maximum RSSI reading can be obtained.

**WARNING:** To review - optimum signal strength is between -50dB and -70dB, -70dB to -80dB may work fine but it is a weak signal, -40dB to -50dB is too strong but in the acceptable range. Below -40 dB you are risking damage to the radio amplifier which could cause failure, open the channel width, decrease transmit power, or misalign radios to cool the signal down into at least the -40dB range.

**Optimize CCQ – Data Rate Selections**

If you have taken all the above steps to optimize your CCQ, and the reading is still low, you can improve the reading by optimizing your data rate selections. Explanation on how to do this follows.

Steps to optimize data rates and improve CCQ on 802.11a units.

1) Look at the links stats tab and note the TxRate, and RxRate.

<table>
<thead>
<tr>
<th>Radio (AP)</th>
<th>MAC Address</th>
<th>Mode</th>
<th>Radio (ST)</th>
<th>TxPR</th>
<th>RxPR</th>
<th>RxRate</th>
<th>TxRate</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBS-AP58 (3.4) Radio1</td>
<td>00:15:6D:6A:84:3D Access Point</td>
<td>BBS-58 (5.4) Radio1</td>
<td>-40 dB</td>
<td>49 dB</td>
<td>99%</td>
<td>22</td>
<td>54.0Mbps</td>
</tr>
<tr>
<td>BBS-AP58 (3.4) Radio2</td>
<td>00:15:6D:6A:84:3D Access Point</td>
<td>BBS-AP58 (6.43.2) Radio4</td>
<td>-51 dB</td>
<td>47 dB</td>
<td>99%</td>
<td>94</td>
<td>6.0Mbps</td>
</tr>
<tr>
<td>BBS-AP58 (3.4) Radio4</td>
<td>00:15:6D:6A:84:3D Access Point</td>
<td>AX35-Test - 6 (6.43.2) Radio1</td>
<td>-42 dB</td>
<td>48 dB</td>
<td>100%</td>
<td>28</td>
<td>24.0Mbps</td>
</tr>
<tr>
<td>BBS-AP58 (6.43.2) Radio1</td>
<td>00:15:6D:6A:84:3D Access Point</td>
<td>AX2-Ext - 8 (6.43.2) Radio1</td>
<td>-43 dB</td>
<td>55 dB</td>
<td>93%</td>
<td>18</td>
<td>54Mbps</td>
</tr>
<tr>
<td>BBS-AP8 (6.43.2) Radio1</td>
<td>6C:3B:40:BF:85:40 Access Point</td>
<td>AX5-Test - 6 (6.43.2) Radio1</td>
<td>-50 dB</td>
<td>52 dB</td>
<td>93%</td>
<td>91</td>
<td>150Mbps-40MHz/1S/5G</td>
</tr>
<tr>
<td>BBS-AP8 (6.43.2) Radio2</td>
<td>00:15:6D:6A:60:02 Access Point</td>
<td>AX5-Test - 6 (6.43.2) Radio2</td>
<td>-37 dB</td>
<td>38 dB</td>
<td>100%</td>
<td>100</td>
<td>24Mbps</td>
</tr>
<tr>
<td>BBS-AP58 (6.43.2) Radio2</td>
<td>00:15:6D:6A:60:02 Access Point</td>
<td>BBS-5824 (6.43.2) Radio2</td>
<td>-50 dB</td>
<td>50 dB</td>
<td>98%</td>
<td>80</td>
<td>96Mbps</td>
</tr>
</tbody>
</table>

2) Note the minimum data rate out of the Tx and Rx rates, if they are mis matched use the lowest reading of the two – in this example it is 72Mbps.

3) Open the configuration window on both radios, one at a time, preferably change the remote radio first. Expand the “Advanced Configuration” menu.

4) On the data rates box, deselect the upper data rates down to the lowest reading from the links stats tab, and write those settings to both radios.
The steps to optimize the 802.11n radios is similar but it has a difference that is worth noting.

If you are using 5MHz and 10MHz wide channel selections then the optimization steps are the same as the 802.11a information above. If you are using 20MHz, 40MHz Above or Below channel widths, the optimization steps are different.

Steps to optimize data rates and improve CCQ on 802.11n units.

1) Look at the link stats tab, and note the lowest Tx and Rx Rate readings. In this example, the lowest reading is 120Mbps.
2) Open the configuration window on both radios, one at a time, preferably change the remote radio first. Expand the “Advanced Configuration” menu.
3) For the N data rates deselect MCS-7 and 6. Then deselect MCS-15 thru 12. So both spatial streams are now set to the 120Mbps data rate from the links stats tab.
By leaving data rates selected for the MCS 1-7, and MCS 8-15, both antennas and spatial streams are still being used.

802.11ac rates are very similar to the 802.11a rates in that you will deselect the supported rates back to the highest rate seen on the link. As stated previously, best throughput on the AX5ac radios is achieved with only MCS0-7 selected on both basic and supported rates using the 802.11 protocol.
Appendix A – System Requirements

Laptop Installation:
- Core i5 processor (Core i7 or better processor recommended)
- 4 GB of RAM
- 5 GB free disk space
- The use of a solid-state drive is recommended
- Ethernet and wireless Ethernet controllers
- Windows 7 with Service Pack 1 or Windows 8
- DVD drive
- Internet access for mapping features

Basic Server Requirements:
- Xeon processor
- 4 GB of RAM
- 2 (4 drives if redundancy is required RAID 5 configuration) drives dedicated
- Windows Server 2008 R2 is required
- 8 GB RAM
- Internet access for mapping features

Preferred Server Requirements:
- HP – DL360 G7 1U configuration with two drives for the Operating System, and two drives dedicated for BroadbandPro™ 5
- 2 (4 drives if redundancy is required RAID 5 configuration) drives dedicated
- Windows Server 2008 R2 64 bit
- 8 GB RAM
- Internet access for mapping features
Appendix B – Technical Information

Channel Width Settings and Data Rates

**BBS and Nitro- 58 Products**
- 5 MHz – Max Data Rate = 13.5 Mbps
- 10 MHz – Max Data Rate = 24 Mbps
- 20 MHz – Max Data Rate = 54 Mbps
- 40 MHz – Max Data Rate = 108 Mbps

**Nitro-58n**
- 5 MHz – Max Data Rate = 13.5 Mbps uses single vertical antenna
- 10 MHz – Max Data Rate = 24 Mbps uses single vertical antenna
- 20 MHz – Max Data Rate = 144 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/40 MHz Above or Below – Max Data Rate = 300 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings

**BBS-49**
- 5 MHz – Max Data Rate = 13.5 Mbps
- 10 MHz – Max Data Rate = 24 Mbps
- 20 MHz – Max Data Rate = 54 Mbps

**BBS and Nitro-24 Products**
- 5 MHz – Max Data Rate = 13.5 Mbps
- 10 MHz – Max Data Rate = 24 Mbps
- 20 MHz – Max Data Rate = 54 Mbps
- 40 MHz – Max Data Rate = 54 Mbps

**BX5 and AX5 Products**
- 5 Mhz – Max Data Rate = 13.5 Mbps uses single vertical antenna
- 10 MHz – Max Data Rate = 24 Mbps uses single vertical antenna
- 20 MHz – Max Data Rate = 144 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/40 MHz Above or Below – Max Data Rate = 300 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings

**AX5ac Product**
- 5 Mhz – Max Data Rate = 13.5 Mbps uses single vertical antenna
- 10 MHz – Max Data Rate = 24 Mbps uses single vertical antenna
- 20 MHz – Max Data Rate = 144 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/40 MHz Above or Below – Max Data Rate = 300 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/60MHz Above – Max Data Rate = 867 Mbps uses both vertical and horizontal antennas. Data Rates set under 802.11ac settings
- 40/40MHz Above - Max Data Rate = 867 Mbps uses both vertical and horizontal antennas. Data Rates set under 802.11ac settings
- 60/20MHz Above - Max Data Rate = 867 Mbps uses both vertical and horizontal antennas. Data Rates set under 802.11ac settings
- 20/60MHz Below - Max Data Rate = 867 Mbps uses both vertical and horizontal antennas. Data Rates set under 802.11ac settings

**BX4 and AX4 Products**
- 5 Mhz – Max Data Rate = 13.5 Mbps uses single vertical antenna
- 10 MHz – Max Data Rate = 24 Mbps uses single vertical antenna
- 20 MHz – Max Data Rate = 144 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/40 MHz Above or Below – Max Data Rate = 300 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings

**BX2 and AX2 Products**
- 5 Mhz – Max Data Rate = 13.5 Mbps uses single vertical antenna
- 10 MHz – Max Data Rate = 24 Mbps uses single vertical antenna
- 20 MHz – Max Data Rate = 144 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings
- 20/40 MHz Above or Below – Max Data Rate = 300 Mbps uses both vertical and horizontal antennas. Data Rates set under the 802.11n settings

**Maximum Transmit Power Settings for Intuicom Broadband Products**

<table>
<thead>
<tr>
<th>Product</th>
<th>Maximum Transmit Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBS and Nitro-58</td>
<td>28 dB</td>
</tr>
<tr>
<td>Nitro-58n</td>
<td>26 dB</td>
</tr>
<tr>
<td>BBS-49</td>
<td>26 dB</td>
</tr>
<tr>
<td>BBS and Nitro-24</td>
<td>28 dB</td>
</tr>
<tr>
<td>BBS and Nitro-5824</td>
<td>28 dB</td>
</tr>
<tr>
<td>2.4 GHz Radio</td>
<td>18 dB</td>
</tr>
<tr>
<td>BX5 and AX5</td>
<td>26 dB</td>
</tr>
<tr>
<td>AX5ac</td>
<td>26 dB</td>
</tr>
<tr>
<td>BX4</td>
<td>26 dB</td>
</tr>
</tbody>
</table>

Copyright Intuicom, Inc. 2020
BX2 = 26 dB

**NOTE:** Adjusting Tx Power settings above the maximum Transmit Power setting will cause it to over drive the radio and signal strength will drop off dramatically. Only use the listed max Tx Power Setting for each radio.
Appendix C – Software Installation Troubleshooting

A) Problems with running the “setup.exe” file

1) **Administrator access** – BroadbandPro™ 5 software needs to be installed into the Administrator profile and made available for all profiles to use. Best case is to log in and run the software as Administrator, so the software will run with no issues.

2) **Missing Files and Folders** – This error can come up during installation, and there are a number of reasons users receive this error shortly after double clicking on the “setup.exe” file.
   a. File was not unblocked after download, before it was extracted.
   b. Antivirus or Antimalware blocking the installation.
   c. Windows Defender blocking the installation.

Suggestions for these first two installation problems is to log in as administrator, and turn off Windows firewall, defender, antivirus, or antimalware software prior to installation.

B) Problems discovering radios

1) **Ping the radios** – If you start BroadBandPro™ 5 and you do not discover any radios check and make sure you can ping the radios IP address from the Windows command prompt. Reasons radios do not respond to a ping are as follows:
   a. Computer IP address not in the same range as the radio IP address.
   b. If going through a router to the radios, there is no route to the radio network.

2) **Incorrect unit login password** – If you can ping the radios IP address but the unit does not show up in the discovery pane, try resetting the unit login password. If your radio is a default, set the password to “admin”, or set the password to the known good password for the radio. To reset the unit login password click on the “Tools” menu, and select the first item in the drop-down menu “Change BroadBandPro™ Unit Login Password” enter the password in the field, and click “OK”. See page 31 of this manual for screen shots and instructions on setting radio and software passwords.

3) **Discovery being blocked by Windows Firewall or Defender** – If possible turn off Windows Firewall and Defender. You may need to call your computer support department and have them configure exceptions for BroadBandPro™ 5 software in Windows Firewall and Defender, if you do not have the authority to turn
them off in your user profile. This also applies to antivirus, or antimalware software.

4) **Unable to write radio settings to the database** – If you can ping the radio, and you have verified you have the correct password, and the radio still does not show up in the discovery pane, try deleting the database file. Close BroadBandPro™ 5 software. Open Windows explorer and go to your My Documents folder. The path is \My Documents\Intuicom\BroadbandPro\Data in the Data folder is a file “BBPData.sdf” highlight the file and press your shift key and while holding it down press the delete key, and permanently delete the file. After you have deleted the file, restart BroadBandPro™ 5, and see if the radio appears in the discovery pane.

After preforming all the troubleshooting steps above to discover your radios, and you are still having problems, please contact Intuicom Support. Contact information is in Appendix D of this document.
Appendix D – Technical Support

Intuicom, Inc.
4900 Nautilus Court N. Ste 100
Boulder, CO 80301 USA
(303) 449-4330 ext 235
(720) 587-9190
dbraddon@intuicom.com
Appendix E – Limited Warranty

LIMITED WARRANTY TO END-USERS

Intuicom, Inc.
4900 Nautilus Ct., Ste. 100
Boulder, CO 80301

A. Standard Limited Warranty for Software Products. For Products that include a software license, INTUICOM makes a limited warranty to the End User that the software will perform substantially in accordance with the accompanying written materials and that the transfer media on which the Product is provided will be free from defects in materials or workmanship under normal use and service for a period of ninety (90) days from the date of delivery (the "Limited Warranty") pursuant to the software license included with the Product. The software license specifically disclaims all other warranties relating to the Products, including any and all other warranties with respect to the performance of the Products.

B. Hardware and Other Equipment Manufactured By Intuicom. Hardware products manufactured by INTUICOM include a limited warranty for defects in materials or workmanship under normal use and service for a period of one (2) year from the date of delivery. Intuicom, at its sole discretion, will repair or replace hardware covered under this limited warranty. Cables, antennas or other accessories manufactured by INTUICOM include a limited warranty for defects in materials or workmanship under normal use and service for a period of ninety (90) days from the date of delivery. Repairs not covered under this limited warranty will be billed as set forth in INTUICOM’s current Hardware Service Policy and Instructions.

C. Hardware Manufactured By Others. INTUICOM makes no warranties whatsoever with respect to Hardware manufactured by third parties. Customers shall look only to the original manufacturer of the Hardware, pursuant to the terms of any manufacturer warranty for any alleged defects and indemnifies and holds INTUICOM harmless from and against any claims by any party related directly or indirectly to any defects in the Hardware, and functional failure, improper operation, failure to operate according to specifications or any other matter related to the Hardware. INTUICOM shall not be liable or responsible for the failure of the Manufacturer to perform under or honor any warranty with respect to the Hardware. Customer acknowledges and agrees that Customer shall have the risk of any loss, damage or functional failure related to the HARDWARE and shall have the responsibility for maintaining the proper operation of the HARDWARE and complying with all maintenance guidelines and specifications from the Manufacturer and all other conditions to receiving warranty coverage from the Manufacturer.

D. No Other Warranty. EXCEPT FOR THE EXPRESS STANDARD LIMITED WARRANTY REFERENCED ABOVE, INTUICOM GRANTS NO OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING THE PRODUCTS, THEIR FITNESS FOR ANY PURPOSE, THEIR QUALITY, THEIR MERCHANTABILITY OR OTHERWISE. INTUICOM DOES NOT MAKE BY VIRTUE OF THIS AGREEMENT OR ANY PRODUCT ORDER, AND HEREBY EXPRESSLY DISCLAIMS, ANY OTHER REPRESENTATION OR WARRANTY OF ANY KIND WITH RESPECT TO THE PRODUCTS.

E. Limitation of Liability. IN NO EVENT WILL INTUICOM BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL, BUSINESS INTERRUPTION, CATASTROPHIC, PUNITIVE OR OTHER DAMAGES WHICH MAY BE CLAIMED TO ARISE IN CONNECTION WITH ITS PRODUCTS, REGARDLESS OF THE LEGAL THEORY BEHIND SUCH CLAIMS, WHETHER IN TORT, CONTRACT OR UNDER ANY APPLICABLE STATUTORY OR REGULATORY LAWS, RULES, REGULATIONS, EXECUTIVE OR ADMINISTRATIVE ORDERS OR DECLARATIONS OR OTHERWISE, EVEN IF
INTUICOM HAS BEEN ADVISED OR OTHERWISE HAS KNOWLEDGE OF THE POSSIBILITY OF SUCH DAMAGES AND TAKES NO ACTION TO PREVENT OR MINIMIZE SUCH DAMAGES. IN THE EVENT THAT REGARDLESS OF THE WARRANTY DISCLAIMERS AND HOLD HARMLESS PROVISIONS INCLUDED ABOVE INTUICOM IS SOMEHOW HELD LIABLE OR RESPONSIBLE FOR ANY DAMAGE OR INJURY, INTUICOM'S LIABILITY FOR ANY DAMAGES SHALL NOT EXCEED THE PROFIT REALIZED BY INTUICOM ON THE SALE OR PROVISION OF THE HARDWARE TO THE CUSTOMER.